
Can you imagine taking on all the commercial 
photography for the world’s largest seller of

dog food? How about doing all the shooting for
the world’s biggest retailer of photographic film?
Or what if a client asked you to provide high-res
image files for all the signage in its 4,600 worldwide
stores? Do you think you could handle the pressure
of producing a marketing publication with a target
distribution of, say, every home in America? 

What if all of this came from one client?
These are the kinds of tasks the Wal-Mart studio

group has to deal with on a daily basis. Led by
Wal-Mart’s Creative Director of Photography Matt
Austad, the new Wal-Mart in-house commercial
studio is an ambitious undertaking designed to
bring all of Wal-Mart’s extensive commercial
image production under one roof.

“One day, I asked, ‘Why isn’t this stuff in
house?’” Austad recalls. “Everything else that 
Wal-Mart has done, they’ve done on their own, 
but they were paying agencies to handle all their
photography. We figured the money they were
spending with all those agencies would fund an
in-house department.”

But this is no casual endeavor. Wal-Mart
recently replaced Exxon Mobil as the world’s
biggest company, and some projections have the
41-year-old retailer doubling its size within the
next five years. Wal-Mart’s $240 billion-plus in
sales dwarfs the GDP of many countries. In fact, 
it sold more in one day last fall—about $1.42
billion—than the total GDP of 36 different nations.
Vendors are so keen to get a piece of this
enormous pie that many have set up satellite
offices adjacent to Wal-Mart’s Bentonville, Ark.,
corporate headquarters, collectively forming an
area called “Vendorville,” where scores of
corporate emissaries eagerly wait in line for that
next big Wal-Mart contract. Yep, it’s big business.
Real big.

“The workload is going to be huge,” says
senior photographer Joey Peña. “We will do
everything from the signage to corporate portraits,
circulars, catalogs, images for Wal-Mart.com and
[Wal-Mart subsidiary] SamsClub.com, packaging
photography, grand opening mailers and publi-
cations put out by Wal-Mart and Sam’s Club.
And then the marketing team comes in with next

year’s target products for big sellers, and we’ll
put together a montage for them. We’ll have
plenty to keep us busy.” 

By mid-summer, the Wal-Mart studio will move
from its current space into a new 23,000-sq.-foot
facility that will incorporate a full kitchen, 
several photo bays for product shoots and a
complete shop for building set parts. Between 
now and next February, the studio staff will grow
to 23 people, including three photographers, 
three junior photographers, two photographic
assistants, stylists, set constructors and project
coordinators. A post-capture production team 
will do Photoshop work and format the large 
RAW image files while an art director lays out 
jobs with low-res copies. 

Digital capture, of course, will be a lynchpin in
the new studio’s workflow. Anchoring the capture
system will be the Sinarback 54 and 43 digital
camera backs, used primarily with the Sinar p3
camera system. “We went with Sinar for
dependability,” says Austad. “I felt the software
gave us the greatest control and most efficient
workflow. My concern was not only the creative
aspect but having an image that was production

ready. I love the way we can calibrate and create
profiles in the software. Joey loves the chip size
[the Sinar system is capable of producing files for
Wal-Mart’s 9-foot-wide store signs] and its ability
to handle lighting effects. For example, if you let
an area fall off to ‘paper white’ on smaller chips,
you would get blooming. The 54 handles the
highlights extremely well, and with the actively
cooled chip, it minimizes noise in the shadows.”

Because it will form one cohesive entity, the new
Wal-Mart studio will be capable of a creative
freedom that was lacking with all the different
agencies handling different parts of the Wal-Mart
account. “We will be able to expand on the
creativity for Wal-Mart since [working in-house] it
won’t cost nearly as much to experiment and try
new ideas,” says Austad. Adds Peña: “Wal-Mart
has its own creative team. They’ll give us a starting
point. We will expand on that, work with different
angles, different styles of lighting. It’s an exciting
opportunity for us and for Wal-Mart.” 

—Jeff Kent, contributing editor
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The world’s busiest 
commercial studio
Wal-Mart’s new in-house photography center
is as ambitious an undertaking as Wal-Mart itself
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T I P S
Photoshop adjustment dialog tricks

When in an Adobe Photoshop image adjustment
dialog box such as Levels or Curves, many people
think they don’t have access to things outside the
box. Here are not-so-obvious things you can do
while adjusting your images:

Hold the spacebar any time you want to use the
Hand tool to scroll around your image. Add the
command/control key to get the Zoom tool and
click, or click and drag to zoom in on your image.
Add the option/alt key to zoom out. I prefer to type
one of the following keyboard commands:

cmd/ctrl-+ = Zoom in
cmd/ctrl-- = Zoom out
cmd/ctrl-0 = Fit on screen
opt/alt-cmd/ctrl-0 = 100% view
Add opt/alt to the top two commands to prevent

the window that contains your image from
changing size when you zoom.

Type cmd/ctrl-H to hide any guides or selection
edges and use cmd/ctrl-; to hide guides but not
selection edges. Type cmd/ctrl-R to show or hide
the rulers. Open or close any palette by choosing
its name from the Window menu. Change the
measurement system the Info palette uses (RGB,
HSB, CMYK, etc.) by clicking on the Eyedropper
icon within that palette.

If you turn on the caps lock key, your cursor will

look like a crosshair whenever it’s on top of your
image. You can add a Color Sampler (with
corresponding readout in the Info palette) by
holding shift and clicking within your image, or
shift-opt/alt-click to remove a Color Sampler that’s
already on your image.

If you’re working on an image that is in RGB
mode, but you plan on converting it to CMYK
mode, you type cmd/ctrl-Y to turn on the Proof
Colors feature. With default settings, that feature
will show what your image would look like if it
were converted into CMYK mode. And if you can’t
quite tell which areas of the image are shifting
when you toggle Proof Colors on and off, try
typing shift-cmd/ctrl-Y and Photoshop will cover
all the areas that will shift with gray.

—Ben Willmore, www.digitalmastery.com 

Your scanner’s sweet spot
You can find your flatbed scanner’s “sweet spot”

by scanning a solid white piece of paper in RGB
mode into Photoshop at 100 ppi. Use Photoshop’s
Equalize command (Image>Adjust>Equalize). Bad
spots in your scanning area will appear with gray
or black patterns as you drag the slider to the
right. Use other areas of the scanning bed for
important artwork.

Use filters on 16-bit images
For critical color in Photoshop 6.0 or 7.0, you

can work with images with more color depth than
the standard 8 bits per channel (for an RGB file this
is called “24-bit color” or “millions of colors”). Not
only do many of the Image>Adjust commands used

for color correction work on 16-bit images, but
most of the workhorse filters—Unsharp Mask,
Gaussian Blur, Add Noise, Median, and Dust &
Scratches—can also be applied. 

—Linnea Dayton & Jack Davis, 
The Photoshop Wow! Book, Peachpit Press 

N E W S
Photoshop 8 features

Rumors of new features for Photoshop 8.0 include
new features for video and digital photography,
including NTSC, PAL and HD previews and support
for non-square pixels; text on a path; nested layer
sets; a Histogram palette; and new “filter layers”
that allow you to apply filters nondestructively. It
should ship by the end of the year and is rumored
to run on Mac OS X 10.2, but not Mac OS 9.

—PC Graphics Report, February 2003

Power supply exchange fixes noisy G4s
Apple is now offering a fix for the unacceptable

noise level of Apple’s Power Mac G4 (Mirrored
Drive Doors) in the form of the Power Mac G4
Power Supply Exchange Program, which sends a
replacement power supply, fan, allen key and
instructions for a shipping and handling fee of
$19.95. The kits may take 4-6 weeks to be delivered.
The program ends June 30, 2003. Details are at
http://depot.info.apple.com/generic/index.html.
For more on this issue, see www.g4noise.com.

—Jay Nelson, Editor & Publisher,
Design Tools Monthly, www.design-tools.com

Talking to the pictures
Letting the computer sort your images

One of the most tedious tasks for a prolific 
photographer is keeping images organized.

It’s not unusual for a stock photographer using film
to shoot hundreds of rolls for one assignment.
Photographers shooting digitally tend to shoot
even more, since there’s no need to worry about
film or processing costs. That means having to
organize and categorize thousands, even tens of
thousands of pictures per month.

Photographers who haven’t kept up with sorting
their images have it even harder. Even discounting
similar shots, discards and photographs that don’t
have resale value, titling and key-wording that many
images can take an extremely long time. Wouldn’t
it be nice if there were a way for a computer to
handle the entire process automatically? 

That’s not possible quite yet, but it may not be too
far off, if Professor James Z. Wang of Pennsylvania
State University has his way. He’s working on a
process called Automatic Linguistic Indexing of
Pictures (ALIP), which trains computers to recognize

and categorize objects within digital images.
Wang, who is with Penn State’s School of

Information Sciences and Technology and the
Department of Computer Science and Engineering,
developed content-based image retrieval
technology while at Stanford University in the
mid-1990s. With it, computers were trained to
find shots in image databases that were similar
to the photos that users selected. That
technology is now being licensed commercially.

He started working on this project when he joined
Penn State. Using 4,600 images that were part of
the Corel image libraries for prototype testing, Wang
and his team trained the computer to recognize over
600 image concepts, each with about 40 training
images. In a recent test, the computer was able
to come up with the perfect set of keywords for
10 percent of the new set of images, which were
primarily travel shots. That doesn’t sound all that
high, but it’s actually quite remarkable, Wang
said, considering the complexities involved in
computerized visual recognition. A much larger
percentage had at least some correct keywords.

It should take a few more years before a limited
working version of ALIP is ready to go. Once the

process has been refined, it should be extremely
helpful in going through large numbers photo-
graphs quickly, in a wide variety of fields. “The
system is very generic; it can be trained to recog-
nize many different types of images, including
medical and scientific. It’s just like information
retrieval with documents. There are many ways to
use it,” Wang said. One of the areas where this
technology is expected to be extremely useful is
Homeland Security, which involves hundreds of
thousands of satellite and surveillance images.  

There are still some bugs to work out. The
computer might
be able to tell that
there’s a beach,
but it has a hard
time distinguishing
the beaches of the
Caribbean from the
shoreline of Hawaii.
But then, so do some
of the clerks who do
the keywording at
stock agencies.

—Ron Eggers



Deconstructing: 
Smashing Pumpkins, final tour

Mirko Ilic, of New York City, created this image
(below) for a 2001 Rolling Stone article on the

Smashing Pumpkins’ final tour (www.mirkoilic.com).
In Ilic’s imagination, after a decade of spilling his
guts in the lyrics of his songs, lead singer Billy
Corgan’s future is open and unknowable. 

Rolling Stone provided a black and white shot of
Corgan, and the desert in the background is 

a Corel stock image, but the rest is pure Ilic. 
He and coworker Lauren DeNapoli built the stage

curtains in Alias|Wavefront Maya 3D animation
and effects software, juxtaposing the vivid red of
the drapes against the black-and-white image to
heighten the drama of the composition. Corgan’s
gown was created in Maya as well, with a silver
texture map and paint effects. The rendered elements,

stock image, and image of Corgan were combined
and prepped for print in Adobe Photoshop.

“This piece got quite a few awards, and I had to
output it on high quality paper to be framed for
various shows,” says Ilic, who delivers work
chiefly in digital format. When subjects, authors
and others request art prints of the work, he
outputs it on an Epson Stylus Color 3000. 

When Mirko Ilic immigrated to New York from
Yugoslavia-Croatia in 1986, he hit the ground
running. Among the first friends he made was
seminal designer Milton—I [heart] NY—Glaser,
who was impressed by Ilic’s artwork, and equally
bemused at the jumble it was in. “I didn’t know
what a portfolio should look like,” says Ilic. 

Glaser offered him the use of a table in his own
studio to sort it all out, and now, years later, Ilic
leases space from Glaser on the floor above the
designer’s 32nd Street studio. 

And because Ilic “didn’t care for rules,” he
simply went knocking on doors when he arrived,
landing a cover for Time magazine as his first
assignment in America and later becoming the
magazine’s art director. He was also the art director
of the New York Times op-ed pages. Ilic’s won
several prestigious awards, including a gold award
from the Society of Publishing Designers, and he
collaborated with Steven Heller on the successful
book “Genius Moves: 100 Icons of Graphic
Design” (Thames and Hudson, originally
published by Northern Lights). 

When we spoke with Ilic recently, he was working
on illustrations for Men’s Health Magazine and
National Geographic, designing a brand identity
for a New York restaurant, and working on a
second book with Steven Heller, “Graphic Scrawl,”
to be published by Thames and Hudson. Ilic’s pro
bono work for nonprofit organizations is ongoing. 

—Leslie Hunt

©Mirko Ilic Corp.

GEAR BOX

Alias|Wavefront Maya 3D animation and effects software,
running on a Silicon Graphics Octane workstation

Adobe Photoshop on a 667MHz Apple Power Mac G4 
(512MB RAM, 60GB hard drive)

Epson Expression 1680 scanner

Epson Stylus Color 3000 inkjet printer

“For making my sketches,” says Mirko Ilic,
“I use the Sharpie .1 fine marker.”

TECHNOLOGY AIN’T ART

“Do not rely on Photoshop filters. Anybody can do Photoshop filters. 
I myself work with Photoshop filters all the time, but that isn’t what makes it my work. 

You cannot just run a filter and proclaim that art. A filter in and of itself is only technology
to enable the ultimate expression. It itself is not art; it is just a bunch of math. 

It is useful but not final. You need to take it a lot further.”
—Jeff Schewe, digital imaging expert and 2002 judge of the Canon Digital Creators Contest. 

To enter the 2003 competition (entries accepted March 24 through September 4, 2003), go to www.canon.com/cdcc for more information.



All images ©Vincent Versace

STUFF I LIKE

Name: Vincent Versace

Business: Versace Digital Natural Light Photography, Los Angeles

Specialty: Digital natural light photography

Web site: www.versacephotography.com

Notable clients: Nikon, William Morris Agency, Mosaic Media, 
San Francisco Presidio 

What’s the product you’re going out of your way to find 
excuses to use?
There are two, the Wacom Cintiq interactive pen display and my
Epson Stylus Pro 9600 wide-format inkjet printer. Using the Cintiq
is a gas and there’s nothing like seeing a large-format print.

What’s the next product you’ve got your eye on?
The 60GB Fortress portable hard drive. It can withstand being
dropped from six feet onto concrete. 

What’s the one piece of gear they’d have to pry out of your cold,
dead fingers?
Again, there are two. My Nikon D1X digital SLR and my Sony
Artisan monitor. Both are how I see the world.
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By Bryan Linden

It takes a licking…
To a photographer or graphic artist working with

digital files in the field, there is no greater fear than
losing data. Two new storage products on the market
bring helpful features to today’s imaging professionals.
A mobile bus-powered hard drive storage solution
from FORTRESS CORP. gives users extreme shock

protection in a FireWire/USB 2.0 enclosure that can
survive a 6-foot drop onto concrete with no data loss
(www.4tress.com). MAXTOR’s 5000DV external
FireWire/USB2 hard drive makes backing up your
files a breeze with a button on the front that auto-
matically initiates a backup (www.maxtor.com).

A loss of original images due to physical shock
could be catastrophic and that’s where the FORTRESS

drive comes in. This
portable unit is the
ultimate for protecting
data and can prevent
disaster during transport
and storage. Other
mobile units can be
damaged by slight jarring
and drops, which are commonplace when
traveling or in the field. Unfortunately, it’s
something I’ve experienced first hand. I’ve worked
with the Fortress drive for several weeks and taken
it on the road to several shows and shoots where
I’ve intentionally dropped the drive close to 50
times—many of those instances on concrete—all
without any problems or loss of data. 

Fortress drives, machined from a solid billet of
Nickel-Plated Aerospace Alloy, employ a patented
shock suspension system and nonskid pads that
also dampen noise. The drives are pricier than
other mobile solutions but provide protection no
other hard drive can. All necessary cables and an
external power adapter are included as well as Nti
Backup NOW! for the Windows OS and FWB
BackUp Toolkit for Macintosh. There’s a lifetime
warranty on the enclosure and a three-year
warranty on the mechanism and electronics.
Compatibility: Windows/Macintosh/Linux. List
price: 20GB, $499; 40GB $599; 60GB $699.

Making backup a breeze
Taking a cue from leading scanner manufacturers,

Maxtor Corp. has adapted the one-touch scanning
button technology for one-touch backup on its
Maxtor 5000 series drives. A push of the button
initiates a backup script that’s automatically set up
during the installation procedure. This is very
handy, as most people don’t remember to perform
regular backups and the button is a visual cue.
Easy setup and flexible software should lead to a
no-excuses backup system. A slightly modified
version of Dantz Retrospect Express for Macintosh
and Windows (to work with OneTouch) is included.
The drives can also be set up to automatically run
backups on a specified schedule. 

The 5000DV drive serves as a standard external
FireWire/USB2 hard drive. Available with 160GB-
or 200GB-capacity, the drives feature an Oxford
911 chipset, 7200RPM drives with 8MB cache,
and stackable cases that can also be mounted
vertically with the included stand. All necessary
cables and an external power adapter are included.
Compatibility: Windows/Macintosh. List prices are
comparable to other external drives that do not
include backup features and software: 160GB,
$299; 200GB, $399; one-year warranty. 

Bryan Linden has been capturing digitally since 1993.
His company, Linden Photography, shoots enter-
tainment, sports, music, commercial and fine art.
You can visit his Web site, www.lindenphoto.net.

You CAN take it with you  
Portable hard drives are getting tougher and smarter

The Fortress storage solution can survive a 6-
foot drop on to concrete.

The Maxtor 5000 series features backup with
the push of a button.

I got Cool, babe
Only in Vegas! A Cher look-a-like 
presented PEI’s Cool2 award winners with
their plaques at PMA’s show in February.

Epson garnered the most awards of all the
2002 entrants with six Cool2s.

Karen Smith-
Pilkington, president

of Kodak's
Professional

Division, accepts for
the DCS Pro 

Back 645 and the
DCS Pro 14n.

Bill Pekala, Nikon's
digital product
manager, accepting
for the Nikon Coolpix
5700, which tied with
the Canon PowerShot
G3 in the consumer
digital category.

Special thanks to Jim Cheyne and Pro
Photo Lab based in Lakeland, Fla. And
big kudos to our talented photographer,
Serene Wright, M.Photog., Alternative
Imagery by Serene, based in Las Vegas.



By Thomas White

A variety of new dedicated film scanners and 
flatbed scanners with transparency adapters

offer the ability to create high-quality digital files.
The performance of many of these models
surpasses that of the best professional models of
only a few years ago. 

MINOLTA’S DIMAGE SCAN DUAL III dedicated film
scanner handles both 35mm and Advanced Photo
System (APS) format film. It yields resolution of
2,820 ppi at a D-max of 4.8, and can make 48-bit
scans into user-selected color spaces. Multi-pass
scanning helps to eliminate random noise in the
finished scans. The Scan Dual III has a Point
Autofocus feature to allow the user to simply click
on an area of the image to determine focus (USB
2.0 interface). MSRP: $449.

The EPSON PERFECTION 3200 flatbed scanner
features the highest resolution of any Epson scanner,
3,200x6,400 ppi. It has a 4x9-inch transparency
adaptor built into the scanner lid. The scanner’s
3.4 D-max is high enough to provide quality 48-
bit scans from both color negative and slide film. 

The scanner is available in two models, both with
USB 2.0 and FireWire interfaces to make connections
easy and fast. The Perfection 3200 PHOTO includes
LaserSoft SilverFast SE 6 software, Adobe Photoshop

Elements 2.0, and EPSON Smart Panel and scan-
ning software. MSRP: $399. The Perfection 3200
Pro adds the full version of SilverFast Ai 6, Monaco
EZcolor 2.5, and ArcSoft PhotoStudio, PhotoBase,
and Panorama Maker utilities. MSRP: $599.

From Denmark, the IMACON FLEXTIGHT 343 film
scanner has Imacon’s innovative “virtual drum”

film mounting system, which holds the film 
flat for the sharpest scans possible without 
the hassle of oil mounting. The Flextight 343 scans
a wide range of film formats, from 35mm to
6x18cm. It has maximum resolution of 
3,200 ppi and a D-max of 4.3 with 48-bit 
color. The Flextight scanner includes Imacon’s
powerful FlexColor software, which does 
a good job of scanning both positive and negative
film with a professional range of user controls and
presets for color correction and sharpening
(includes FireWire interface). MSRP: $4,995.

The AZTEK PLATEAU professional flatbed scanner
uses X-Y axis scanning and three independent
lenses to capture 48-bit color over a 14x18-inch
scan area. With an extremely high optical
resolution of 16,000 ppi, the scanner boasts a

scanning capture speed of 16MB per second. 
Aztek specifies this model’s D-max value at 4.8,

way over the “industry standard” of other
manufacturers. The Plateau uses Aztek’s Digital
PhotoLab software, which offers a density-
calibrated ICC-compatible workflow. Digital
PhotoLab is remarkably effective at scanning
color negative films—a struggle for many
scanner programs—with excellent results on
even poorly exposed slide film. MSRP: $18,990.

Scanners demystified

In the last few years scanning technology has 
matured to the extent that some of us take it

for granted. But there are still practical issues
you need to understand before choosing the
best scanner for your needs.

Configuration. There are two basic config-
urations and one variation: CCD scanners
(flatbeds and most film scanners) and drum
scanners, which use vertical or horizontal
photomultiplier tubes (PMT). Scanners such
as like Imacon’s  are hybrids—CCD scanners
in which the film is held in an arc, similar to a
drum scanner design.

Opinions vary, but some still believe that the
PMT technology of drum scanners produces
the highest scan quality. In PMT scanners, a
focused light source (such as a pulsed xenon
light) passes through a series of optics to a
fixed point on the rotating drum. 

These scanners’ exceptional optical resolution,
high bit depth and dynamic range have always
been a selling point. But the latest desktop
scanners are challenging drum scanner technology,
by presenting comparable features of their
own. Glassless carriers like the Microtek 1800f
eliminate light diffraction, loss of sharpness
and Newton rings. Glass carrier designs as in
the Epson Perfection 3200 Pro and Expression
1680 Professional scanners are just as sharp. 

Sensors and dynamic range. Dynamic
range, the sensor’s ability to resolve a contrast

The latest scanners 
Affordable scanners with high-quality files

SMART TIPSMART TIPSMART TIP
If you’ve ever performed color
correction on your images and later
noticed that the contrast changed too
much, you might want to try this
technique. Immediately after color
correcting your image, choose
Edit>Fade and set the popup menu to
Color. This prevents the last
adjustment you made from changing
the brightness or contrast. If you
used an adjustment layer, do the
same thing by setting the blending
mode menu at the top of the Layers
palette to Color.

—Ben Willmore,
www.digitalmastery.com



ratio, is measured by two standards, density and bits
(the amount of tonal data) per pixel. Minimal quality
scanning of continuous tone images requires at
least 8 bits per pixel. Sensors that capture more than
8 bits per pixel yield more accurate color. A gamma-
corrected, calibrated scanner that captures 10 bits per
channel can resolve 1,024 shades in each color
channel, mapped to 256 discrete values. A 12-bit
scanner maps 4,096 shades for each color channel
to 256 values. 

Dynamic range is often defined in terms of optical
density. Density (D) is the degree of opacity of a
transparent or reflected image. Density range is the
range of tones in an image, from the lightest (D-
min) to the darkest (D-max). D-max minus D-min
equals density range; e.g., 3.20D – 0.10D = 3.10D. 

Because photographic transparencies rarely have a
density range greater than 3.3, and reflective prints
rarely have shadow density greater than 2.25, you
could say that it’s unnecessary for a scanner sensor
to identify density greater than 3.5.

Dynamic range. Unfortunately, scanner
manufacturers do not follow a standardized method
for measuring dynamic range. Different kinds of
density measurement targets contribute to differing
results. Whose method or target is correct? Often
referred to as “a rubber ruler,” this means that you
can’t use the manufacturers’ stated density range to
compare models. 

I took it upon myself to test a few scanners to see
how the actual dynamic range compared to the
manufacturers’ claims. I tested an Epson 1680
Professional FireWire scanner, an Epson Perfection
3200 Pro, and a Microtek ArtixScan 1800f. In each

case, the makers’ claims were more ambitious than
my findings. Some scanners offer a multiscan
option to reduce shadow noise by averaging the
results of several scans. In my tests, these scanners
gained a half- to full-stop range.

Resolution. We all know scanner resolution is the
number of pixels it can capture per inch. A number
of formulas can help you determine if a scanner can
provide adequate native optical resolution for image
enlargement. 

You need to know: the dimensions of the print or
film original; the resolution required for the final
print; and the scanner’s maximum, uninterpolated
optical resolution. 

Multiply the size of the film original by the optical
resolution, then divide the result by the image
resolution. This gives you the maximum print size.
For example, if the original image is 1.5 inches
(35mm), and the scanner’s maximum optical
resolution is 3,200 ppi, and you need resolution of
200 ppi for your final print, then 24 inches is the
largest print you can make at 200 ppi with the
scanner’s native resolution of 4,800 ppi:

1.5 x 3,200 ppi = 4,800 /200 = 24 

Scanning bit depth vs. high-bit editing. Most
scanners can capture 10, 12, 14 or 16 bits per
channel. Scanners that use high-bit-depth sensors
achieve better shadow separation, smoother tonal
gradients and greater color accuracy. Usually, the
scanner’s internal software decides which are the
best 8 bits of information to use and discards the
rest, but some scanners can also save the high-bit
data.  It’s a misconception that the more bits are

saved per channel, the better the scans. For
example, if a 48-bit scanner delivers 16 bits per
channel, you might assume this 16-bit scan will be
of greater quality than the same image scanned at
12 bits on a 36-bit scanner. But in my experience,
you’d be hardpressed to visually distinguish a
difference between 36-, 42- and 48-bit scan. 

Software. The most important factor in getting the
most from the scanner hardware is the software. It’s
the defining factor among models with comparable
hardware specifications. 

Scanner software should at least have curves and
levels adjustments available, and ideally, highlight
and shadow samplers for targeting contrast range,
and an info palette. Also look for the ability for
selective color correction using an LCH color
model, which allows easy adjustments via lightness
(grayscale), chroma (saturation), and hue (tint)
values, rather than RGB numbers. 

In researching scanners, you’ll quickly find plenty
that have similar specifications. I recommend trying
out the vendor software for ease of use. Check out
third-party software like LaserSoft Imaging
SilverFast for more advanced control. If you’re torn
between two scanners from different makers, take
along a range of your typical film or prints when you
go to the dealer, and get a demonstration. Check out
the scanning speed, ease of operation, functionality
of the tools, and the quality of the scans.

Having the best equipment does not guarantee the
best results. Training and support services from a
local dealer help in realizing the full potential of your
purchase. 

—By Dan Reid with Jim Rich contributing

The 2003 Pulitzer Prize in Feature
Photography was awarded to
Don Bartletti of the Los Angeles
Times for his portrayal of
Central American youths who,
often facing deadly danger,
travel north to the United States.
Bartletti used two Nikon F-100
film bodies and two zoom lenses:
a 20-35mm and an 80-200mm.
He had the cameras and a
strobe and about 30 rolls of film
in a backpack so he could run,
crawl, climb ladders and jump
from car to car on the moving
trains. "When I captured this
image, I had been riding the
train for about 12 hours," says
Bartletti. "At dawn I climbed to
the top as the locomotive far
ahead disappeared into a solid
wall of fog. A lone boy was sitting
a couple cars ahead. I ran over
the tops of the cars and made a
few frames just before we hit
the fog.  Because of the noise,
I don't think the boy even realized
I was there. I feel the photo-
graph is a metaphor for the
entire migratory route.  A lone
child, an uncertain future ahead."
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